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Paesigner

Cenario

Rodar programas em C
Permitir temporizagdo
Transmissdo serial
Detecgdo de eventos
assincronos
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Prazo do Projeto

Requisitos do Projeto

(Paesoner

Agenda

» Motivacao para o projeto de SoCs

« Principais desafios para o projeto de SoCs
« Padrédo SPIRIT

o PDesigner

Plataforma (SoC) 2 S,
P,
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Plataformas MPSoC

Utilizacdo de maltiplos
processadores SoCs

Alta performance
| I I

« Baixa poténcia Interconnection network
. Device  Device
« Baixa frequéncia de clock ey (IP) (IP)
« Utilizacao de processadores
heterogéneos
& e |
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SystemC TLM (Transaction Level Modeling)

» Comunicagao utilizando chamada de fungdes
« Pontos Fortes: > &
- Simplicidade (.o -
Rapido e compacto \
Integracao de modelos de hardware e software
Suporte a reuso de design e verificacao de IP
Usabilidade
Transparente a:
« Nivel de Abstragao
« Diferentes arquiteturas de comunicagao (barramento, NOC, ...)
« Diferentes protocolos
« Principais conceitos:
- Fluxo de dados Unidirecional x Bidirecional
- Requisices e respostas separadas
- Blocking x Nonblocking
@ - Uso de sc_port e sc_export 4 A
GrecO i |

template < typename REQ , typename RSP >
class tim_transport_if : public virtual sc_interface

public:
virtual RSP transport( const REQ & ) = 0;

SystemC TLM - Arquitetura Basica

tim_transport_if |
virtual RSP transport( const REQ & ) = 0;

tim_transport_if
transport(.)

« sc_export exports tim_transport_if for use by outside world
« RSP transport( const REQ & ) is implemented in the slave
« tim_transport_if is the tim bidirectional blocking interface

C)‘m,/\'mbiente de Desenvolvimento SPIRIT: IP-
XACT

SPIRIT SPIRIT Compliant SPIRIT Compliant
Compliant IP SoC Design Tool Generators
SPIRIT
Design Capture~ LGI/TGL e
configurator
generator

* 161 mayke depracated i s lenses

i
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SPIRIT
« Padrao definido por um
consorcio de empresas para e
distribuicao de IPs N

« Baseado em XML

» Descricao de IPs
independente de linguagem

iews.
RTL(VHDL Verilog)
TLM (SystemC, SystemVerilog)

Interface Configurator
Componen

1P Configurator

| B¢
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SoC Design Tool

@ 13
GrecQ
7
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Interacées de Objetos IP-XACT
/ | design |‘/"‘
\\( A @
\'/r——-,,,,, | bus | ¢
definition 3
G 5
oretd

« Design: descreve as instancias de um componente e as
interconexdes entre as instancias. As interconexdes
definem as conexdes ponto-a-ponto entre interfaces dos
componentes.

« Gerador/Configurador: sdo objetos executaveis
utilizados para gerar os componentes ou configura-los.

Q
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Geradores/Configuradores

Q
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< Bus definition: é um objeto que descreve uma interface
interface de barramento (nomes de sinais, direcao,
largura, uso) e as restricdes que se aplicam a estes
sinais.

» Meta Data: € um modo que pode ser interpretado por
ferramentas para se descrever diversos aspectos do
projeto

( IPagsigrer
Exemplo Simples de um SoC

er_1
(generafor)

!
ambaAPB_if — masterAPB_if
bus_1 (AP3_bus)
7 — —
A JaveAPB T 2 JaveAPB T 3
slaveAPB if_1 slaveAPB_if 2 siavenrb i uart_interface
bR it |

[
| |

slave 3 uart_verifier

(uart) (uart_tester)

(irqetrl)

slave_1
(timer)

slave_2 ‘

Q
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Exemplo Simples de um SoC: Design File

<7xml wersion="1.0" encoding="UTF-8" 7>

<gpirit:design
HLnS:SPirit="http:// v, spiriteonsortium, org/ XNLSchema/ SPIRIT/ 1.2
xmins:xsi=hetp://ww. 3 .org/ 2001/ ¥MLSchema-instance
xgigchemalocation="http:/ /Wy, spiriteonsortiu. org/ XHLSchewa/ SFIRIT/ 1.2
http://vww, spiritconsortium, oro/ KMLSchema/SPIRIT/ 1.2/ index , xad ">

“<spirit:interconnedvions:
</apirit:design>

Nome do SoC

Identificador da versao

@
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Exemplo Simples de um SoC: Design File

e itertace

i |

<spirit:interdwgnections:

<spirit:intercombection:

<spirit:activelnte Spirit:componentRef=rhus 17
<spirit:activeInterface spirit:componentRef="master 17
Spirit:busRef="anbalPB_if" />
</spirit:interconnection>

@
=
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Exemplo Simples de um SoC: Design File

<spirit:component Instances:

spiriteonsuctinm ueg”
rary="Leona”
timer”

20
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Framework

« Modelagem e Simulacao de plataformas e processadores
« Analise de componentes
« Reuso de componentes (IP)

23

© oo
- A o]

@
=
@
o
k=)

-
1
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Paesianer

Arquitetura

Eclipse

Plugins

PCacheAnalyzer ‘

PBuilder ‘

PDLybrary

E SystemC H GCC H SPIRIT ]

24
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Plugins

« PDLibrary

o Plugin PDBuilder

e Plugin PArchC

« Plugin IPZip

o Plugin Help

o Plugin PCacheAnalyzer

25
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Paesigner

Framework - v1.0

~ GRAPHICAL S
EDITOR PALETTE

PLATFORM
VIEW

(paesionr

PDLibrary

« Biblioteca dindmica
« Configuracdo através de arquivos XML
« Repositorio de Componentes divididos em subtipos:
- Processadores
- Memoria
- Barramento
- Wrappers
- Devices
- Memoria Cache

27
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Plugin PDBuilder
* Modelagem de plataformas
- Instanciagcao de componentes e conexdes graficamente
- Configuracao de plataforma
« Geracao, Compilacao e Simulacao da plataforma
- Geracao do modelo de plataforma
- Compilacao da plataforma
- Geracao do simulador da plataforma
- Resultados da simulacao exibidos no Console
T
6recd 2 A izt

cr

PDBuilder - Views

« PEditor
- Editor que possibilita a modelagem de plataformas graficamente
- Componentes da biblioteca distribuidos na paleta de componentes
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PDBuilder - Views

» Platform View « Outline
- Miniatura da plataforma - Lista de componentes
modelada instanciados
PMIRY - Platform view x W =n [ == ouliine ~ N

@ ClackMadel

target_port
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PDBuilder - Views

S properies 2 : "%« Properties
sapary vake
- Tabela editavel com
bigers i as propriedades do
subtpe simple_bus componente/platafor
vebose fise ma selecionada
« Console xo 2@t

- Mostra resultado

de compilagao, 55 e, o o1e, o 0, oz oot
simulagao e
analise ]
E
3

6rec) i |

PBuilder - Perspectiva de Simulacao

33 Sintormatica |
6recd o~
C}lﬂlll’
Plugin IPZip
5 .
+ Wizard de geracao de
distribuicao de
componente i e
e foawed ——[¢]
« Gera pacote de A

distribuicdo com arquivos | et

de configuracéo SPIRIT a L=]

partir da descricao alto

nivel do componente

PBuilder - Perspectiva Grafica

o o Soms
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( Paeioner

Plugin PArchC

.

Plugin focado na construcéo de proc.
Processadores Structure S8

Ambiente grafico para edigao de codigo 1 I

- Inclusdo do destaque para palavras Generate Simulator
reservadas do ArchC l

.

.

Compilacao e Simulagdo do processador 1sS
- Possibilita ao usuario verificar o
comportamento do componente

Export to Library
« Distribuicao de Componente
- Gera automaticamente um pacote de
distribuicdo do componente baseado no component
padro SPIRIT BELy

GrecQ
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Plugin do Help

[ EEE]
s r nee

—— B Pltiorm besaner el eslmdan
@ Workbench User Guide. PDesigner Plugin Installation 2
© Java Development user Gukde i : .

< g his secion descrises howta nstl e POesignr Pugin

© 307 Pug-n Develoer e

@ poc uide Basic Steps

¢ T ot must R ntaled systame sosion 21, ArHG 20 and Syt TUH ool

2 Uzt .

ArchC paihy it st pont to
2 oo SystomC path it must p
3 The LM patt tmust point 1

ehC 20 man diectory path
systeme varsion 2.1 main dsctry path
i dsctoryinsids the TL man diectory.

System Variables

B toonert Here you can se the system variables associated withFlaform
> ane auier Pugin
> cress encpan  [ustrocovarcnc2o [Cmowse|
> e - —
Systmc pane: [ [Cmowse |
> netanpaste
b Java Tum path. [usrocaimLm. ostim| [ mrowse |
atrorm Designr - Lbrary
> Pugin Development
> Runebug
System Variaies
< 3 | ream B
[ s 1 O s

6reco - - ]




« Analise preliminar de cache

« Analise de diversas configuragdes
de caches (+ de 50) com apenas
uma simulagao

« Geragao de relatorio,
identificando:
- Configuragao da cache (tamanho
de palavra e associatividade)
- Hit Rate
- Miss Rate

« Relatorio mostrado em formato
HTML

Grec)

Plugin PCacheAnalyzer

Model the Platfom
(Including cache analyzer component)

Platfom Simulation
Trace of referenced addresses

Single-Pass
Cache Analysis

|

Cache miss rate report
for the entire Configuration space

Configuration Space

Configure cache devices
Final Platform Simulation

oy o Foums
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Plugin PCacheAnalyzer

256byes  16bytes  1-way 338157 430333 %
256byes  16bytes  2-way 338157 3.9041%

cobyies  ibbyies  3-way Ssind Freey

2 338157
S2hyies  16hyes | d-way TmIST 23716 %
Sl2byes  32bytes  1-vay 338157 256715 %
Sl2byls  32bytes  2-vay 338157 195797 %
Sizbyles  3zbyles | 4-vay 338157 188256 %
Sl2byks  Gibyes  1-way 338157 292113 %
Sidbyks  Gibpes 2 way 338157

a5 o Foms

- A s

« Configurar variaveis do |

Passo 1 : Configurar Ambiente

. opererten [v]  system v
S]Stema % Senem, Here you can set the system variables associated with Platform
- SystemC I Systemc pan: [Rsfocaisystame 2171
- TIM > Trpan: [tocarin 2005 oaaenim _gromse_|
§ Foghboimet |
» runoens
« Deve ser configurado
para cada workspace
novo!

|
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Fluxo de Projeto

e
[ R e
(_MPSuC Execulable Simulator )

)
A eimaes ]
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« Selecionar biblioteca

EEEEE]v) | Poesioner ubrary =
de componentes } ool -
- Apenas uma biblioteca | v cer+ eoubrary path: [hemormasgoedaoppo [_grouse: |
por workspace ? s R

« Editar biblioteca

- Importar componente Z:mvm\es ::‘:;ﬂ | [ romove Componen: |
- Remover Componente cache.t3 |
cache_snaeer ]
T 2 [Restoro pefauts] [_awpty ]
[ carcel ]
22 ®cwwe

Passo 2 : Selecionar Biblioteca

b nstaliUpdate

b e mips) (e companere_]

b plug-in Devalopme il
b Runpebug amba
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Passo 3 : Criar Projeto

Plataform Project

1. Selecionar a opcao ~ [Enmmmm
File > New > Project

To Create a Plataform Project

Quner:

designer name

2. Definir o nome do
projeto

Team:

Greco

Description:

3. Dados do projeto

PDesigner Tutorial Example

4. Projeto criado no

workspace
[<geck | Comen ) [Ccameel )
-,
43 S ntormatica |
GrecQ So s

(paesionr

Passo 5 : Editar Componentes

« Tipo do
componente

« Nivel de Abstracao

« Parametros
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Passo 7 : Mapear Aplicacao

1. Selecionar a opgao ]
Load Application File nO
menu de contexto

Select Binary Application

2. Selecionar a
aplicagdo (arquivo
executdvel)

| select Memory:

Select Memory: Adress:

ok Cancel

3. Selecionar Memodria

4. Definir o endereco

Grec)

Jhome/maag/Desktopftest 1| Browser

47
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Passo 4 : Adicionar Componentes

1. Selecionar tipo do
componente na

paleta ‘v"“ | Z
) :::Aw
e
2. Escolher posicao no A
editor
3. Inserir componente
...
Grec0 4 -y iormaues—}

(paesionr

Passo 6 : Conectar Componentes

1. Selecionar origem
(porta mestre)

BA

2. Selecionar destino
(porta escrava)

3. Criagdo automatica
de wrappers

4. Ver / Editar
propriedades da
conexao e/ou
wrappers

W oo 5.
A s
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Passo 8 : Compilar Plataforma

« Selecionar
PDesigner >
Compile
Platform

e Resultados e
Logs da
compilagéo
s@o
mostrados na
view Console

T R TARA] ® i e o RS
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Passo 9 : Simular

« Selecionar a opcao

Run PDesigner no

menu de contexto
do projeto

« Resultado da
simulacéo é
mostrado na view
Console

g
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Grupo de Engenharia da Computagao -

Cin/UFPE

( Paesoner

Exercicio 1

1. Modelar no PDesigner a plataforma ao
lado.

2. Mapear as aplicacdes FFT na plataforma
acima.
1. FFT

I

2. FFTinversa ‘

3. Adicionar cache(s).

4. Altere os niveis de abstragdo das caches
e tipos de barramento a fim de
encontrar a melhor configuracao de
plataforma, levando em consideracao
apenas a performance.

| Grec0

Grupo de Engenharia da Computaca
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Generate 1PZip Define Component Constants. i
1P2Zip File |
!
|
'
|
{
1
G | =
; 53y Momps SO
o

-Cin/UFPE

( Paesioner

Passo 1 : Criar Projeto IPZip

€ 1PZip Project

1. Selecionar a opgéo File >
New > Project

1PZip Project
To Create a P Zip Project nto the speciyed place

2. IPZip > IPZip Project
r

w

Selecionar diretério onde o
arquivo zip sera criado

g

| Grec0

Grupo de Engenharia da Computagao-Cin/UFPE
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1PZip Project
1PZIp New Project
Name:

[mips1

Type:

[processor
Owner.

=3

Vendor:

[Arnc

Library:

mips1
Descrption:

Mips Processor 1F]

@ [ <mack | mear

=T

[~ N RN = |

Passo 2 : Informagdes do Componente

cancel
- 5 ]
6rec) i
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Passo 4 : Configurar Parametros

. Name (VR eI
Nome do parémetro s comonet s

« Description
Descrigdo do pardmetro informando e g
seu papel

. Grom Descpon:  Themame fhe ke used i the Systemc Hes

ot pvameis

Nome do grupo que o pardmetro deve o
pertencer, organizando os pardmetros o = =
do componente por grupos i 5]

+ DataType v £
Tipo do dado P

« Resolved by e " |
Informa se o parémetro deve ser =
modificado pelo usudrio ou pelo
sistema

« Format na_|
Informa se o pardmetro tem valores Parameters
diversos (texto) ou restritos (choice) Remove

« Default Value Ea
Valor default do parémetro

L <ok | mews |[emsr ][ cona ij
57
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Passo 6 : Nivel de Abstracao

« Definir nome do nivel de
abstracao
Normalmente séao
denominados TL1, TL2 ,...
« Selecionar o nivel de
abstracdo do componente
Pode ter mais de um, sendo
necessario configurar cada um
deles
Possiveis niveis:
« Cycle accurate
+ Timing estimated
+ Untimed
« RTL
« Verilog

@
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Abstsction Leves

Descbe the companentpons

Abstaction Level
Tyve s fiming estmased

Abstacton Levels

L sk | mew s e

cr

#include "mips1_arch.H"
mips1_archi:mips1_arch()
roh_dec. f<mips1_ parm:ac_word.
parms:iac_Hword=(mips1_parms::AC_MAX_BUFFER),
p).

= mips1_parms::AC_ MATCH_ENDIAN;
= mips1_parms::AC_PROC_ENDIAN;

™ = 20m:
APP_MEM = 5DM;
)

Passo 3 : Configurar Interfaces

Describe

Name:

T
pr—

New o

Prtocol Decton[master

e
comecton eased [
s space sz 5 o b )
RS

the P Comparert pors

DMpot

|
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Passo 5 : Arquivos Fonte e Makefile
« Listar os arquivos fonte do IP
« Identificar Makefile do IP \E

ket

mipsLisaintcpp
s syscaln
mps2 syscallcpn

cr
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Passo 6.1 : Arquivos

« Selecionar arquivos fonte do
componente que deverao ser
incluidos para possibilitar sua
utilizacao.

const char
const char *|
const char *;
const char *archc_option

#include "mips1.He
#include “loader.h”

int sc_main(int ac, char *av[J}{

}

e i

[

arcapmi

10
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Passo 6.2 : Constantes

« Define constantes e namespaces
- Function : namespace, const, ...

- Name : nome da constante ou do
namespace

Value : valor associado

const char *project_name="
const char *project
const char *arch
const char *archc_

#include "mips1.H*
#include “loader.h”

int sc_main(int ac, char *av[)){

g et g e, s, ) mt b n i .

=)
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Passo 6.4 : Configurar Estrutura de Conexao

it sc_main(int ac, char ‘avi))
{

AvalonController bus (‘bus", clock, 2, 1, 1);

mips1 mips_proc("mips1");
simple_bus_fast mem mem_fast('mem_fast", 0400, 0X3FFFFF);

bus.addMaster(WORD, faise, 1, 1);

bus.addSlave(WORD, false, 0x00,0x3FFFFF, 0, 0, 2, true); = hd
mips_proc.DM_port(wrap_mips1.target_export);
1 0
L
0 e e
GrecQ -~
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Importar IPZip

Selecionar a opgdo:
Window > Preferences >

Heskon Sl
PDesigner Library s iinsies (A et 2|
S
Soovene

Selecionar Import

Component e

Selecionar o arquivo
IPZip

Selecionar Apply

S sasy rve

(| Brmaresan)

(7 cortestapplt.conf 5262006
(5] Documerto: abw SAED 0112005

3 Documerta- bak-

30-01:2006

e

21.01:2006

© oo
. - Ay iermaues—}

int sc_main(int ac, char *av[)) {

mips1 mips1_proc1 (‘mips1"):

AvalonController bus ("bus”, clock, 2, 1, 1);

Instancias

@"’"" Passo 6.3 : Configurar Estrutura das

i e o Compret s

[ —————rE——_—
-

o e Vi
e
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Passo 6.5 : Configurar Estrutura das Funcoes

int sc_mainfint ac, char *au)
(

mipst mips_proc("mips1");

|
/Functon e
mips_proc.int); B Er| I =
I Log Function 3
e proe Prnsia(:
, =
[ e
L ==
6 e s
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Exercicio 2

g

67 A,f‘"" wrea |
| Grec) Grupo de Engenharia da Computagdo-Cin/UFPE & 3
Referéncias
 www.pdesigner.org
« www.archc.org
* www.systemc.org
* www.spiritconsortium.org
« www.eclipse.org
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